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Printing Mailing Labels 

Instructor: Sean Luster 

Introduction 

The purpose of this class is to learn to speed up the task of printing a large group of labels 

using Microsoft Word’s Mail Merge tool.  Hopefully this will not only help with this 

specific goal, but also serve as a bridge to learning about other automated tools and tricks 

buried in the office programs. 

For today’s task we need to identify the 3 major steps involved in this process: 

1. Creating a data source 

2. Merging the data 

3. Printing the results 

Each of these will be discussed in detail and through the use of several examples. 

Creating a Data Source / Organizing the Information 

There are many different acceptable ways to organize information to work with a merge; 

for the purpose of this class we’ll focus on the most common choices. 

Word Tables 

If you want to stay within MS Word while creating the address list then the only option 

available is using a table.  Tables are Word’s organizational tool, a spreadsheet with 

fewer options and a bit more flexibility.  The are the steps involved in creating a table: 

1. Left-click on the “Table” menu then choose “InsertTable” 
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2. This window will appear:  

3. Select the number of columns and the number of rows required for the 

information to be entered in.  This can be changed later on but it’s simplest to 

make the correct setup from the beginning. 

4. Choose the appropriate Auto-fit behavior (depending on whether all columns 

should be the same size or should adjust to their contents) 

5. If desired left-click the AutoFormat button and select a color layout for the table 

6. Click OK and the table will appear on your screen (showing here): 

 

7. Enter in content putting categories across the top (name, address, etc) and 

individual entries in row by row.  Use ‘tab’ to move from cell to cell: 

 

8. Repeat this process until the entire set of addresses is entered in 

9. Save file with an identifiable name (this will be called upon when it’s time to 

merge and print the labels) 

Using this information will be visited when we reach that section. 
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Excel Spreadsheets 

If you are comfortable with Excel or would like to become more comfortable with it then 

working with an Excel spreadsheet to organize your information might be a great way to 

go.  There are many advantages to keeping information in Excel – it’s more flexible, has 

better tools for sorting and filtering, is easily expanded and changed in the future – but in 

the end it’s a matter of personal preference and what software is available.  Should you 

choose to work with Excel here is a quick rundown on entering data into a sheet: 

1. Open Excel, note that the blank screen presented is already in spreadsheet form: 

 

2. Identify the cells, columns, rows, worksheets, and the cursor/box 
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3. Moving the cursor/box using the arrow keys or tab/enter select the appropriate 

cells and enter the information in.  Formatting effects familiar to Word users are 

also available. 

4. Use the “Insert” menu to insert rows or columns if necessary 

5. Save file with a recognizable name and to a location that will be easy to find when 

performing the merge. 

Outlook Address Book / Access Database 

We won’t be working with Outlook or any database applications in class today since 

setting up outlook for an individual user can be a complicated and time consuming task 

and databases are bit more complex than we want to get tonight.  I just want it to be clear 

that both Outlook and Access are acceptable ways to store this address information and 

move it into mailing labels (in Outlook by storing it in the address book, in Access by 

creating a properly organized table). 

 

Merging Addresses into Label Format 

First we’ll cover the specific steps involved in merging to labels, after that you’ll notice 

the handout has a complete discussion about using Mail Merge for other topics.   

Merging Address Data into Labels 

To take the data that’s been organized and put it into a format that will print correctly 

onto labels, use the following steps: 

1. Left-click the “Tools” menu 

2. Select “Letters and MailingsMail Merge” NOT “envelopes and labels” 
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3. Notice the task pane to the right taking on this menu:  

4. Select “Labels” and left-click “Next: Starting document” to continue 

5. In Step 2 under Change document layout select “Label options…” 

 and select the appropriate model number for your labels 

6. If your labels are unidentified or the model number isn’t available from the list 

(unlikely) the option to create a new label and adjust the dimensions is available 

from the label options screen. 

7. Left-click “Next: select recipients” 

8. If taking data from a table, spreadsheet, or database select the button “Use an 

existing choice” – if working with Outlook left-click “select from Outlook 

contacts” 

9. Under “use an existing list” left-click “Browse…” 

10. Select the file containing the address list 
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11. This screen will appear: 

 

12. Using the controls built in here to select what entries in the address book to 

include and how to sort them 

13. Left-click “Next arrange your labels” 

14. Under “Arrange Your Labels” left-click “More Items…” then select from the list 

of fields created in your data source (the table or spreadsheet). 

15. Left-click Update All Labels then click “Next: preview your labels” 

16. Check to see if everything looks the way it should, if changes are necessary go 

back and edit them, if not left-click “Next: complete the merge” 

17. The final step allows you to send the labels to print immediately or send them to a 

different file where they could be individually edited or accessed later on. 
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About Mail Merge 

Mail Merge, although it has many different features and possible uses, serves a much 

more specific purpose than the macros we were just discussing.  In the simplest sense a 

mail-merge operation is the bringing together of two parts, a database and a document.  

The database can be just about anything (we’ll use names and addresses since that’s the 

most common use), and the document can also be in almost any form (form letter, 

envelope, catalog, telephone book, time log, label, etc.).   Although Word can’t perform 

the extensive merging operations of a real database manager it’s certainly the easiest tool 

to use when you want to generate a document or series of documents based on data in a 

reasonably clean list. 

 We will cover how Mail merge allows you to: 

1. Sort and/or filter incoming data 

2. Print envelopes or mailing labels 

3. Force the merge process to pause at each record to allow you to customize the 

information going in. 

 

Creating Form Letters With Mail Merge 

Although I just listed several different applications of mail merge this remains the most 

common.  For that reason we’re going to go through a mail merge procedure step by step 

creating a form letter. 

This process is much less confusing if we take it a step at a time and try to identify all the 

problem areas.  Remember we have two different parts that need to be created.  First the 

document you want the data merged into then the data table itself.  Follow these steps: 
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1. Create a new document 

2. Enter in all the static information that you want to be the same for all the letters 

3. Enter all the information you want into the database, use either a Word Table, 

Excel spreadsheet, Access table, or Outlook Address book. 

4. Click “ToolsMail Merge” and this window should open: 

 

5. This outlines the three things we need to do, identify the main document, identify 

the data source, and merge the two together. 

6. Click on “Create” 

7. This will give you a list of items which you can create.  Choose “Form Letters…” 

8. Mail Merge Helper will give you the choice of using your current window or 

creating a new document, choose “Active Window” 

9. Now we need to determine where we want the data to come from, so click “Get 

Data” 

10. To save time I’ve created the data source already so choose “Open Data Source” 

11. Find the file on the desktop. Open the file you want the data to come from. 
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12. The Mail Merge Helper will notify you that you don’t have any data fields listed 

in your document and will ask if you want to add them.  Say yes and the screen 

will return to your document. 

13. Notice that there’s a new toolbar at the top of the screen. 

14. Position mouse where you want a data field to go 

15. Click on “Insert Merge Field” and choose the field you want 

16. Repeat until the form letter is as you want it. 

17. Click the Preview button to see how the data will look when merged into the 

document. 

18. If satisfied click the Merge button, this window will open: 

 

19. We want to merge to a new document but you’ll see if you pull down the menu 

the option is there to go directly to the printer or to E-mail 

20. You can also control how many records are entered in with the “Records to be 

merged” frame 

21. Another major option available is determining whether you should print blank 

lines when the data field is empty.  This is important for situations like allowing 

for two address lines.  Some people will need to have a space for an apartment 
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number, others won’t.  Don’t need to have an empty line messing up the 

appearance. 

22. If you want more specific controls over what information is entered, say you only 

wanted to enter only people from Illinois, you can use the “Query Options…” 

23. To control the files that are entered into your document use the “Filter Options” 

screen shown below (we’ll discuss specifics in class): 

 

24. To control the order that the records are entered into the form use the “Sort 

Records” screen:   

      

 

25. When you’ve performed all the specifications click “Merge”.  A new document 

will have been created 

 

A lot of little steps but your document should now be completed.  Each of those forms 

gets it’s own page for easier printing.   
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Creating Mailing Labels with Mail Merge 

This will be very similar to the above procedure so I’ll just explain the little differences.   

1. Of course when you choose what you want to create choose Mailing Labels not 

Form letter 

2. After you select the data source you won’t be told that you need to enter the 

merge fields into the form letter, you’ll be told that word needs to set up the main 

document; do so. 

3. A screen will open up asking you what kind of labels you’re using, this is very 

important, make sure that you choose the correct make and model.  This allows 

word to space everything correctly so all the labels will line up when printed. 

4. After you select a label you will be asked to set up the sample label.  Here you’re 

doing the same thing you did with the form letter, determining what information 

goes where.  We’ll go over this thoroughly in class. 

5. Then click Merge. 

Printing Labels 

When printing off of a merged list nothing more is required than following the steps to 

perform a normal MS Word print (i.e. left-click “FilePrint”) and putting the label paper 

properly into the printer.  However, if printing individual labels or printing an entire page 

of the same label (a return address, for example) different steps are required: 

1. Left-click “ToolsLetters and MailingsEnvelopes and Labels 

2. Select the Label tag and enter the address in the box provided 

3. Select the appropriate label model and choose print 


